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Introduction   

SpEdDoc 10.0 or newer contains state mandated special education and Medi-
caid forms (released Summer 2011), as well as most 2011 child count specifica-
tions (a further CC update will be released), but look to the Vermont DOE and 
your special education director for guidance concerning the implementation of 
these forms. This manual is organized according to the files in SpEdDoc (paral-
leling the SpEdDoc navigation buttons). The manual occasionally refers to the 
SpEdDoc Manager – the database administrator in your SD/SU who is responsi-
ble for overseeing the database. The SpEdDoc Manager should also refer to the 
SpEdDoc 10 Administration guide.

This manual is continually under development to reflect the latest SpEdDoc ver-
sion. Consequently, you will need to run the latest version of SpEdDoc in order to 
access all the features referenced in the manual. SpEdDoc 10 requires at least 
FileMaker 10.

The current version of the manual is posted on the SpEdDoc web site: www. 
SpEdDoc.org. There you will also find guides on specific topics such as Medi-
caid.  As always, feedback on the manual and SpEdDoc is much appreciated: 
speddoc@myfairpoint.net

Begin

Log in (for Case Managers)

Launch SpEdDoc with the SpEdDoc.fp7 file. For stand-alone users, this is lo-
cated in the SpEdDoc Folder on your computer. For your convenience, you may 
create a shortcut to that file. Network users should get directions from your net-
work administrator to connect to SpEdDoc. The Start SpEdDoc 10 file is available 
for configuration to simplify remote connections from a FileMaker client.

To use SpEdDoc, you need to know the SpEdDoc 10 Account Name and Pass-
word (check with your SpEdDoc Manager regarding the Account Name and 
Password). Further, to access a caseload, you’ll need your personal User Code. 
These are generally assigned by your SpEdDoc Manager. 

Enter the same User Code every time you log in to access your caseload. Each 
case manager needs a unique User Code because SpEdDoc uses the code to 
permit access to the case manager’s student data. Users without a caseload do 
not need a User Code, but instead use an administrative password (see instruc-
tions in the next section).
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Enter your User Code and click the Submit button (do not press the Enter key). If 
you already have a caseload of students under that User Code, a list of their 
names appears to the right of the Submit button. The list is alphabetical (scroll 
down to view the end of the list). You can click on a name to go to that student’s 
Main Data record in the Student file or click on the Go Students button to go to 
the List View. 

Tip: SpEdDoc alerts you if it does not recognize the User Code you entered. If 
that happens, clear your entry and reenter the User Code (taking care to NOT 
press the Enter key before clicking the Submit button). 

Log in (other than Case Managers)

With FileMaker Server, personnel other than case managers can access the data 
over the school network. These personnel can be given access at the Student, 
School or SU-levels. Student level access is provided through User Codes (be-
sides the primary case manager, up to four additional users may be assigned to 
each student). The school password allows access to all records with that school 
in the CM School field on Student: Main Data. The SU password provides access 
based on the SU entered in the Org ID field on Student: Main Data. If you enter 
the wrong password or have no records that correspond to the password, then 
you will see a message to that effect. When entered correctly, the balloon indica-
tor turns green when the Submit button is clicked. School and SU-level pass-
words are entered in the Begin: Admin layout. Passwords may be obtained from 
your local SpEdDoc Manager.

Student

Entering and Managing Student Records

Once in the Student section, you can manage existing student records or start 
new ones. Locate students in the Student section with one of several methods:
• Click on List View on the navigation column. On List View, click the button to the left of 

the student name to go to that student’s Main Data. 
• Navigate between students by clicking on the book icon on the upper left of the layout 

just under the Layout menu. 
• Select the Find button on the bottom of the screen, type part of the student’s name in 

the Student Name field and click Continue.
• Use the Student Name as Popup field on the Find screen (network users may experi-

ence a slowdown with this method). 

Tip: You can usually tell where you are in SpEdDoc by viewing the navigation 
column on the left of the screen. The blue button in the top section of the naviga-
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tion column shows which file you are in while blue button in the bottom section 
shows the current layout (so the current file and layout names are blue). 

If you don’t already have a record for a student, check with your SpEdDoc Man-
ager to see if a record exists elsewhere (if so, the existing record can be trans-
ferred to your caseload). Otherwise, create a new record by clicking on New Stu-
dent on the bottom left of the Main Data screen. This takes you to the Main Data 
screen where you can enter the name of the student along with other information. 
Enter information thoroughly on this screen before creating documents because 
information automatically transfers at the time forms are created. The Facility is 
the school the student attends while the CM School is the case manager’s 
school. The CM School should be in your SU to ensure that all password levels 
provide access (so assign a CM in your SU even if another SU has child count 
responsibility).

Tip: The Facility and CM School drop-down menu is customized for your SU/SD. 
If the student is attending a Facility that does not appear on the drop-down menu, 
go to Student: Main Menu and select the Add Facility button on the bottom of the 
screen. Click once in the School ID field to open the drop-down menu containing 
all the Vermont schools. Type the first letters of the school name to jump down 
the menu, scroll until the desired school is highlighted and then press Enter to 
add the facility.

Dates in the Main Data Tracking box fill automatically from documents such as 
the cover pages of IEP’s and Evaluations. To enter dates when these documents 
have not been created in SpEdDoc, click on the Tracking button on the naviga-
tion column. In Tracking, enter the Initial and Most Recent eligibility dates as well 
as the IEP Meeting and Initiation dates. These update automatically on Main 
Data when you create IEP’s and Evaluations in SpEdDoc. Also enter Meeting 
Dates in Tracking for students with Services Plans, 504 Plans or Educational 
Support Plans. Enter the other fields in Tracking if you are instructed to do so by 
your administrator.

The Contacts bold label fields under Primary Contact transfer to documents and 
are used for child count, so Contacts should be completed ASAP. While they 
don’t transfer to documents, the Secondary and Other Contacts may be com-
pleted for convenient reference.
 
Tip: Each student may have multiple IEP’s and other documents in SpEdDoc, but 
should have only one record in the Student file. Always be sure to check with 
your SpEdDoc Manager before starting a new record in Student. If you create 
multiple records for a student in the Student file, you will eventually have to de-
lete the multiples and may lose some data in the process.
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Notes and Contact Logs

Click the Notes button in the Student file to access a screen for entering notes. 
You can enter up to ten pages of notes per student.

Click on the Contact Log button to enter an unlimited number of dated contact 
notes. On the Contact Log screen, click the Add New button to create a new en-
try. To print the current entry, click on the printer icon to the right of the entry. To 
print the current set of entries, click on the Print Log button. To select a set of log 
entries to print, use the All Logs List button, enter Find mode (click on Scripts on 
the FM toolbar above the layout and select Enter Find Mode) and then use File-
Maker Find techniques.

Tip: Users can enter a contact message and then click the envelope icon to 
transfer it to your email program (unless you are connected to a remote server 
via Terminal Services). This allows you to maintain a record of email correspon-
dence related to a student in SpEdDoc. Familiarize yourself with local policies 
and procedures related to email correspondence before using this feature.

Navigating and Creating Documents 

Most screens have a pair of buttons above the navigation column. When green, 
they can be clicked to go backward or forward (of course, the forward button is 
only available after using the backward button).

The second navigation method is to simply click on a button on the navigation 
column, e.g., if you click on IEP, then you will go to the most recent IEP for the 
current student. If there is no IEP for that student, you will see a Message giving 
you an option to go to Portals to create a New IEP or, if you select Open, to go to 
a list of existing IEP’s for other students. 

The third method is to navigate through Student: Portals. There you will see an 
overview of the sub-records for the current student, e.g., IEP, Evaluation, Meeting 
and Written Agreements (click on the Medicaid tab in Portals to view sub-records 
dealing with Medicaid or the 504/ESS tab for Section 504 or Educational Support 
sub-records). In Portals, there are buttons on the left for creating new sub-
records. To go to an existing sub-record, click on the Go arrow at the beginning 
of the line containing the sub-record. To permanently delete a record, use the 
trash can icon at the end of the line containing the sub-record (this deletes all the 
documents on that line). If you create multiple sub-records for a student, you can 
scroll between them in Portals. 

5



Spell Check

To check spelling, go to the FM toolbar and select Scripts > Check Field Spelling. 
This checks words in the current field (the field that your cursor is in). To check 
words on the entire layout, select Scripts > Check Record Spelling. Spell check 
can also be accessed with a single click on the Standard toolbar (click the icon 
with a checkmark below ABC). If the Standard toolbar is not already active, select 
it from the FileMaker toolbar (View > Toolbars > Standard).

Questionable words in the current field (words not in the dictionary) are under-
scored with red dots. To obtain assistance with an underscored word, right click 
on the word (Control-click for Macs) and select Suggested Spellings. The first 
time you add words to the dictionary, you need to select a dictionary:
• Go to Edit - Spelling - Select Dictionaries and click Select Dictionaries.
• In the Select Dictionaries dialog, click New.
• Name the file (e.g., User Dictionary), select a Save location (e.g., navigate to the 

SpEdDoc Folder on the root level of the hard drive) and click Create.
• In the next dialog, select the second option (i.e., Use Main Dictionary and User Spell-

ing Dictionary) and then click OK.

Once the User Dictionary is created, FileMaker can learn words. When a user right 
clicks on a red underlined word and selects Suggested Spellings from the contextual 
menu, the option to Learn the word appears below the Suggested Spellings list. Click on 
Learn to add the word to the dictionary.

Lists and Reports

A variety of Lists and Reports are available in Student: Main Menu. Lists can be 
sorted simply by clicking on the italicized headings, e.g., in IEP Due, click on the 
IEP Due heading to sort by due dates (those with no date show first, followed by 
those with earlier due dates). Customize lists using buttons on the bottom of the 
layout. Click on Active for User to display only your active students (based on 
Status in Student: Main Data) or All for User to include all the students on your 
caseload. For example, you might select Active for User so that your list doesn’t 
include New Referrals and Exited students. Admin users can use the Show All 
button to view all the students that are accessible under the school or SU pass-
word.

Click on the Find button to refine your criteria further. For instance, if you select 
Grade 5 for Grade and Emotional Disturbance for Primary Disability, then you will 
get all your Grade 5 students with that disability. Then select one of the Lists or 
Reports to view the found students.

Reports summarize data according to preset criteria. Many of the Reports are 
designed with school and SU level users in mind (e.g., they summarize by case 
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manager).  Other Reports summarize by grade, placement or disability. When 
done viewing a Report, click on the Continue button. Then print or cancel printing 
to return to Student > Main Menu. 

The Find Services report has its own sophisticated find and reporting capability 
for IEP Services, as detailed in the SpEdDoc Find Guide.

Plan Date by CM and Eval Date by CM reports automatically find records with a 
CC Status of Active, Tuition or Unilateral. Find IEP’s or Evaluations that are com-
ing due by entering a number next to the List or Report button on Student > Main 
Menu. For example, enter 30 next to the IEP Due List button and then click on 
the button. This will yield a list of students with IEP’s due in the next 30 days (or 
overdue). 

List View automatically flags IEP’s and Evaluations for students with an Active  
CC Status that are coming due or overdue. IEP’s that are due within 30 days and 
Evaluations that are due within 90 days have yellow flags while overdue is indi-
cated by a red flag. Select Active or Exit in CC Status on Main Data for students 
who will be reported in the current child count census. Use the other CC Status 
choices for students who are not part of the current child count or will be reported 
by another SU/SD. 

The CC Status choices are:
Active: Currently special education eligible.
Exit: Exited since the last CC report. If for December you need to report students who 
were missed in the prior June CC report, then be sure to check the “Exited previous pe-
riod” button below the Exit Reason. Do not exit students who were not in special educa-
tion, e.g., don’t exit a student who was evaluated but never qualified.
New: Under evaluation but eligibility not yet determined.
None: None of the other CC Status choices apply (e.g., students exited in a previous 
CC reporting period or were never eligible).
Tuition: Special education eligible and receiving services in your SD/SU, but will be re-
ported for CC by another SD/SU (e.g., school choice students from another SD/SU).
Unilateral: Special education eligible, but will be reported for CC by another SD/SU 
(e.g., students placed by the family in a private school outside your SD/SU).

Auto-Fill Data

Data entered in Student automatically transfers to documents when you create 
them, e.g., when you go to Student: Portals and select New IEP, Eval, Medicaid 
or Meeting. Most of this data does not automatically update in existing docu-
ments when you make changes in Student (the student’s name, CC number and 
birth date are exceptions). This is so old documents reflect data that was accu-
rate at the time they were created. However, you may wish to update an existing 
record because you discovered an error. In that case, update the data in Student, 
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go to the document, click on the Records menu on the FM toolbar above the lay-
out and select Relookup from Student. This updates all of the auto-fill information 
for the current student record, e.g., if you are currently on Johnny’s IEP, that IEP 
record will update. The Relookup from Student feature is not available for the 
Medicaid Logs or Written Agreements.

Printing

Most layouts have a print button on the upper right hand corner (but find the Print 
button on the bottom right for Lists or, for Reports, select the blue Continue but-
ton). Preview your document prior to printing by holding the shift key while click-
ing the print button (let go of the shift key after the preview appears). Note 
whether text needs to be moved and then click Cancel to return to your docu-
ment to make adjustments (depending on your computer operating system and 
printer, the preview may not precisely reflect the printed output). Reports auto-
matically go to preview (no need to hold the shift key).

Multi-page layouts include text boxes with scroll bars and allow substantial room 
for text entry (use Preview to verify that everything prints). One-page layouts, 
e.g., most notices, consents and agreements, do not contain scroll bars and only 
print the amount of text that fits in the original boundaries of the text box, even if 
you type beyond text box borders. 

Print, Preview or Create PDF for IEP and Eval

Print IEP and Print Eval are buttons on the IEP and Evaluation layouts that allow 
printing of all, or selected portions, of the document at one time. If you need to 
select a printer other than your default, then uncheck the No Print Dialog box on 
the Print IEP or Print Eval dialog. This permits selection of an alternate printer 
before each part of the report prints.

To preview an entire IEP or Evaluation, click the Select All button followed by the 
Preview button. Likewise, to save a PDF document to your desktop, click the Se-
lect All button followed by the PDF button. Note that the PDF feature requires 
that you have FIleMaker 9 or newer running on your computer (it won’t save the 
document to your computer if you are connected to the server with Terminal 
Services or Citrix).

User Value Lists

Many forms contain fields with popup menus or lists. Menus are not editable be-
cause they already contain all of the allowable choices but users can edit lists. To 
add items to the popup lists, go to the document that contains the popup list you 
want to edit and then go to Scripts on the FileMaker toolbar and select Edit User 
Value Lists - current area. This takes you to a layout with columns for each of the 
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popup lists used in the current section of SpEdDoc (note that the IEP User Val-
ues layout has buttons on the left to access popup lists pertaining to different 
parts of the IEP). Most columns/lists are independent, so don’t bother lining up 
items across unless the columns are linked (as indicated by a blue background). 
List items automatically alphabetize when accessed on the forms.  

To view all of the SpEdDoc User Value Lists at one time, go to the Layout Menu 
at the top of the left hand column (above the book icon) and select User Values. 
You may need to click on the column heading in order to group the items at the 
top of the layout or scroll down to see all of the values that have been entered.

The Services list contains case management and related service items that ap-
pear red on the Services data entry layout. Do not modify these. Modification to 
these items will interfere with the AutoLOC feature for generating Medicaid LOC 
forms.

IEP

IEP Main Menu 

To add items to the popup lists that appear on forms in IEP, click on the Edit User 
Value Lists button. This goes to a layout with buttons on the left side to access 
the IEP popup lists. There are also several IEP reports that can be accessed 
from buttons:
• IEP Status - view whether basic data has been entered in sections of the IEP.
• Duration - view summary of IEP’s with initiation and duration dates.
• Transition - view summary of IEP’s for students age 16 or older.
• Goal Progress - view summary of progress reporting for selected IEP’s.
• Find Services - conduct a search of IEP services.
• Find Accommodations - conduct a search of IEP accommodations.
• IEP at 3 - find which students transitioned to a IEP at age 3.

IEP Cover Page

If information is complete in Student, much of the top section auto-fills when a 
new IEP is created. Click on the Fill from Meeting button to fill all the names from 
the latest meeting notice onto a cover page. Once entered on the cover page, the 
IEP Meeting Date and Initiation Date automatically transfers to Student Main 
Data. The Annual Review Date auto-fills on the cover page based on the IEP 
Meeting Date, but you can override this by manually entering a date (e.g., if a 
student is about to graduate). Double-click the Name and Position fields to type 
in them. Single-click to select from a popup list. By default, new IEP records 
show Parent in two locations (change to Adult Student, Guardian or Surrogate, 
when appropriate).
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Under the print buttons is a Duplicate IEP button to create a new IEP for the 
same student. The new IEP contains the same information as the original, except 
that it excludes most of the dates found on the cover and above the progress re-
porting fields. It also excludes progress codes and notes that were entered on 
the old IEP. This allows retention of the old IEP without having to start a new IEP 
from scratch (do not overwrite the original IEP). When duplicating an IEP, you 
may uncheck sections that you don’t want duplicated. For instance, if you want to 
duplicate all but the goal section, uncheck that box in the Duplicate IEP dialog.

Click the Draft check box on the left side of the page to make IEP pages print 
with Draft in the footer. Uncheck the box before printing the finalized IEP.

Also on the left side of the IEP Cover are buttons to create IEP Amendments or 
Revisions. When conducting a meeting to amend an IEP, click the “New” button 
to create a document that is similar to the IEP cover page but includes additional 
information concerning changes made to the Annual IEP. Team member names 
transfer from the original IEP, so it will be necessary to add or delete names to 
indicate participation in the amendment. Check the appropriate boxes to indicate 
the sections amended and, while the changes can be made in those sections of 
the IEP, you may also summarize the changes on the bottom of the Amendment 
document. If changes are made to an IEP without a meeting, click the IEP Revi-
sions button instead of IEP Amendments.

When the IEP document is done, click the Written checkbox to the left of the IEP 
cover page. This communicates to other users that the document is complete 
and locks the IEP to help prevent accidentally overwriting it. Check the Unlock 
box above the Written Date if the team agrees to further changes. Note that IEP’s 
are also locked when the IEP expires after the last duration date (a cob web ap-
pears at this point).

IEP Present Levels

Big Edit buttons are available to the right of text fields (click on a button to ex-
pand a data entry box). By default the Glance Include boxes are checked. To ex-
clude a section from printing in IEP-at-Glance, uncheck the corresponding box.

IEP Progress Notes

Enter up to eight progress reporting dates using the mm/yy format. Enter pro-
gress codes in the corresponding columns when reports are due. The DOE pro-
gress code key prints on each goal page. The optional narrative Progress Note 
prints if you select a print option that includes the note. Access the progress nar-
rative field by selecting the Progress Note tab on top of the main goals page. 
There is one narrative note per IEP Area, so organize your entries on a cumula-
tive basis, e.g., enter the date of the current progress period before adding note. 
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To expedite progress reporting, create a found set of your current IEP’s by click-
ing the Find IEP Meet <370 Days button below the Goal page print buttons. 
• Navigate between IEP’s using the Book icon on the upper left of the screen to 

complete progress reporting. 
• To print the found set of Progress Reports, select a Print Option with Progress.
• Click to the right of the Print button to switch the selection from Page to Recs. 
• Click the Print button.

IEP Goal Areas
Starting with the 2010-2011 school year, the DOE requires that each goal be as-
signed to an Area (e.g., basic skills) and that Present Levels information be en-
tered for each Area. Consequently, Areas should be created before entering 
Goals: 

• Go to the main Goals page to select the New Area button. 

• Enter the name of the Area (Categories from the Goal Bank popup as options, 
or double-click to type a different entry).

•Click on the Large Edit button to the right of the Area to view 
the four Present Levels fields for that Area. 

• Enter Present Levels informa-
tion in the first three fields.

• For the fourth field, click the Se-
lect GE button to the right of the 
Grade Expectation field to go to 
the GE Find Screen and enter 
your find criteria (the GE Bank 
includes the Reading, Writing 
and Math GE’s). Select a GE to 
enter it in the Area. 

• Click the Select GE button again 
to add another Grade Expecta-
tion (you can add as many as 
you want for the Area).
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•Click Done to return to the list of Areas you created for the IEP.

•Click the New Area button on the main Goals page to repeat the 
process if further Areas are needed.

IEP Goals and Objectives

Click the Show Goal button to the 
right of the Area to go to a page for entering goals for that Area.

Click the Large Edit icon on the right side of a goal or objective to fill the screen 
with the selected goal or objective. After editing, click Done to return to the cur-
rent Goals page.

Enter one goal or objective in 
each box (putting both in the 
same box may lead to print-
ing issues and complicate re-
porting). The goal number 
serves to organize your goals 
and objectives (everything 
with the same goal number 
prints together). Start num-
bering with Goal 1 in each 
Area. 

To create a goal, select the 
New Goal button located on 
the upper right, write the goal, 
select the appropriate Vermont Standard, and enter the evaluation procedure. 
Indicate if a goal is for Reintegration, Extended School Year or Transition by 
checking the boxes just below the progress code fields. 

Add objectives by selecting the button with the yellow icon on the right hand side 
of the goal record just above the trash can. Change the order in which goals and 
objectives print by renumbering them. To insert a goal without renumbering the 
existing goals, enter a decimal number, e.g., to insert a new goal in between 
goals 2 and 3, enter 2.1 as the goal number. Delete any extra or blank goals or 
objectives using the trash can on the right side (leaving blank records creates 
printing issues). 
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After entering the goals and objectives for the current Area, 
click Done to return to the main Goals page with a complete 
list of Areas you created for the IEP. By default, the Goals 
section prints continuously (Print Options: Continuous) but 
you can start a new page for each Area (Print Options: Break 
Before Area). There are two similar options to generate a 
Progress Report. Include a Progress Note that you may 
have written by selecting Print Options: Continuous (Progress) or Break 
(Progress).

Assigning Goals to Areas (Duplicate IEP)

After duplicating an old IEP as a starting point 
for creating a new one, users can move Goals 
between Areas:
• Duplicate the expiring IEP (with Goals box 

checked).
• Go to the main Goals page and select the 

New Area button. 
• Enter the name of the Area (Categories from 

the Goal Bank popup as options, but you 
can double-click to type a different heading).

•Click the New Area 
button and repeat the 
process if further Ar-
eas are needed.
•After creating the Ar-
eas, click on Show 
Goals for the first Area 
(the one containing all 

the old goals).
• On the Goals and Objectives page, select the Move Goals 

button.
•  On the Move Goals page, check the box for each goal and ob-

jective that will be moved to a single Area, e.g., Basic Reading.
• Then click the Select Area button to view a list of all the Areas 

you created (ex-
cept for the cur-
rent one). 
•Select the Area matching the 
goals/objectives that were 
checked in the previous step.
•Repeat the process to assign 
the remaining goals to the ap-
propriate Areas.
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Goal, Rubric and Accommodation Banks
While IEP’s can be created without using banks, the banks are useful when en-
tering the same goal, rubric or accommodation in multiple IEP’s. It’s also a way 
for networked users to share goals, rubrics and accommodations. Goals, rubrics 
and accommodations can be transferred from the banks to an IEP, but not vice 
versa (unless you copy and paste). So, if you think you’ll eventually want a goal, 
rubric or accommodation in the banks, it makes sense to enter it there initially. To 
leave the banks and return to the current IEP without transferring anything to it, 
click the Return button on top of the bank screen.

Entering Goals from Bank into an IEP

Goals in the bank can be transferred to the current IEP 
(the current IEP is indicated on top of the Goal Bank 
screen). Navigate to the desired IEP Goal page and se-
lect the Open Goal Bank button. Transfer a goal along 
with its objectives using the Enter Goal button to the left 
of the selected goal. If your selected goal includes more 
objectives than you want, use the Omit button to remove 
the extras before completing transfer of the goal. Or, after 
you add them to the IEP, use the trash can buttons on 
the Goals layout to delete the extras. Either way, if the 
deleted objectives are not numerically last, then you’ll need to renumber the re-
maining objectives after transferring the goal to the IEP. Modifying goals in the 
Goal Bank changes the bank, while changes made in an IEP are specific to that 
IEP.

To find an existing goal in the bank, 
click the Find button on top of the Goal 
Bank layout. Then enter one or more 
search criteria and click Continue to 
view your results. Entering multiple 
criteria yields a narrower result, e.g., if 
you enter Reading as your Category 
and your name as Author, you will only 
get your own Reading goals. The big-
ger the bank, the more specific you 
will want to be in your find criteria. It 
will also help if you refine your catego-
ries, e.g., rather than simply Writing, create categories such as Writing - Re-
sponses, Writing - Conventions and Writing - Spelling. 
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Goal Bank Button Row

The button row accesses the following features:

• Return to IEP: To return to the current IEP without adding goals.
• Enter Goal: To enter the current goal and its objectives (except for any objectives 

omitted using the Omit button).
• Enter Entire Found Set: To enter multiple goals at once. 
• Collect Goal: To create a found set with just one goal and its objectives.
• Find: To find goals based on the Category or a range of other criteria.
• Show All: To return to the full set of goals.
• All For: To find goals for which you are the Author. 
• Print: To print the found set of goals.
• New Goal: To add a new goal to the bank (assigned the next available number).
• New Objective: To add a new objective for the current goal.

Goal Bank Overview

The Goal Bank should be structured similar to one (very) large IEP. As with an 
IEP, each goal should have a unique goal number and each objective should 
have both the appropriate goal number and an objective number. A major differ-
ence from an IEP is that student names should not be included (if you put names 
in the bank, they could inadvertently wind up in other IEP’s). Further, the goal 
bank sorts primarily by Author, then secondarily by number (so it’s OK for differ-
ent authors to have the same goal numbers).

Access the Goal Bank with the Open Goal Bank button on the Goals page. Here 
you can view existing goals and enter new ones. To add goals to the bank, click 
on the New Goal or New Objective button on top of the screen. The New Goal 
button creates a new record with a goal number that is one greater than the 
highest previously-entered goal, e.g., if the highest numbered goal in the bank 
was 68, then the new one will automatically be numbered 69.

The New Objective button creates a new objective record to go with the current 
goal, e.g., if you are on goal number 69, the objective will have a goal number of 
69. The current goal number is indicated to the right of the New Objective button. 
To add an objective to a different goal, first navigate to the desired goal and click 
on the area where text is entered. Since that goal number appears to the right of 
the New Objective button, clicking the New Objective button creates an objective 
record to go with that goal. Objectives are numbered automatically when select-
ing the New Objective button but may be manually reordered.
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Enter goals by typing in the goal text box. Your name as the goal author appears 
automatically based on the User Code entered when you logged into SpEdDoc. 
The Author field is important because goals in the bank are primarily sorted by 
author and secondarily sorted by goal number (consequently, the objectives for a 
goal must reflect the same Author). Enter the Category, Standard, Grade Expec-
tation and Evaluation Procedure (if these items are left blank in the bank, you will 
need to enter them each time after transferring goals to IEP’s).

Enter data in the remaining search fields for each goal to assist with locating 
goals as the bank grows:
• Skill - Basic skill area addressed.
• Set - Identifies goal sets created for shared distribution.
• Level - Local field to distinguish levels, e.g., ECP, Elem, Middle, HS.
• Sub-Category - Place to further break down the Category.

Refer to the student by entering in the Goal Bank as <<STUDENT>>, <<HE/
SHE>>, <<HIS/HER>> or HIM/HERSELF (case sensitive). Don’t put actual 
names in the bank because they could end up in IEP’s for other students. For 
example, enter in the into the goal bank as follows (SpEdDoc automatically trans-
lates when the goal imports into an IEP):

Goal as entered in Bank:
<<STUDENT>> will read to solve problems: Given any one of the basic shapes 
(circle, square, triangle) and the question, "What shape is this?" <<HE/SHE>> 
will use preferred communication to express the name of the shape on ___ % of 
occasions over __ consecutive trials. 

Goal as imported from Bank into Jimmy’s IEP:
Jimmy will read to solve problems: Given any one of the basic shapes (circle, 
square, triangle) and the question, "What shape is this?" he will use preferred 
communication to express the name of the shape on ___ % of occasions over __ 
consecutive trials.

Clicking in the Category field will pop up a list of any existing category labels in 
the bank. Select from the list or double-click the Category field to remove the list 
and type in the new Category label (the new label will automatically be added to 
the list). Categories added to goals in the bank also appear in the Services page 
Category field.

Click the button to the right of the Vermont Standard field and, in the next dialog, 
choose from the list of Vermont Standards categories (early childhood standards 
are prefaced with E) and click Continue. At the next screen you will see a list of 
all the Vermont Standards for the selected category. Click on one to transfer it to 
the goal (if you had previously selected a Standard, a dialog asks if you want to 
replace it with the new one).
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Click the button to the right of the Vermont Grade Expectation field and, in the 
next dialog, select find criteria and click Continue. At the next screen, select a 
Grade Expectation to transfer it to the goal (if you had previously selected a 
Grade Expectation, a dialog asks if you want to replace it with the new one). Note 
the choice of the GE Stem or the full GE. The Evaluation Procedure does not 
have a pop up (click in the field and manually enter your criteria). 

Rubrics

Rubrics may be created in an IEP or, to reuse in multiple IEP’s, in the Rubrics 
Bank. To create a Rubric for just one IEP:
• Click the Add New Rubric button. 
• Enter enter a Topic.
• Select the IEP Goal (from the current IEP) associated with the Rubric. 
• Select the column headings (selecting the first heading changes the set). Delete the 

last heading if your Rubric only has three levels.
• Click the Add New Row button for each row needed.
• Enter rubric content.
• Click Done to return to the IEP Rubrics layout.
• Click the blue band under a Rubric to expand it.

Click the Open Rubrics Bank button to enter rubrics in the bank or select a rubric to 
transfer to the current IEP. The Rubrics Bank works similar to Rubrics in the IEP, except 
there are additional search fields: Author, Skill (select a basic skill area) and Level (local 
field to distinguish levels, e.g., ECP, Elem, Middle, HS). Select the Enter Find Mode but-
ton to search the bank. Select Return to IEP Rubric to search the bank.

Transition

Transition now includes clickable icons to 
view examples for many of the items. 
Complete the Transition page for students 
who will be 16 or older during the life of the IEP. SpEdDoc provides a red re-
minder if the student meets the age requirement for a Transition plan. The red 
message remains until you enter enter text in each field on the Transition page 
(with the exception of the last field, needed only for students turning 17). Pro-
gress codes must be reported for transition goals (either on the Transition page 
or the Goal page, depending on where the transition goals are entered).

The Transition Multi-Year Plan at the end of the Transition section of the IEP is 
only required for students with a MYP, and only prints if at least one record (row) 
is created (click the New button to the left of the portal to start a row). Note that 
the MYP has its own print button to the right of the portal (to print the MYP with-
out the rest of the Transition Plan). The MYP should be complete, so use the Du-
plicate IEP function to copy from year to year.
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Services List

New: Beginning with SpEdDoc 10.1, new services are entered by first clicking the 
Add Services button located on the upper or lower right of services portal or on 
the middle left of the portal. 

The first Services tab, Services List, is the place to list services. Before adding 
services, enter the initiation and duration dates on the Cover Page. Those dates 
then appear on the upper left of the Services List screen. The currently selected 
set of dates attach to newly-added services. Use the Custom line to enter a date 
range that differs from those on the Cover Page (e.g., when the IEP is amended). 
Dates can also be edited directly on each service line. The printed services will 
be grouped in chronological order. Dating each service makes it clear when each 
service begins and ends.

If the same services are provided during different timeframes (e.g., now until 
June, and then August until the end of the IEP), it is not necessary to retype each 
service. Instead, enter the services for the first timeframe. Then click on the Du-
plicate Services button to the right of the Services portal. On the Duplicate Serv-
ices screen: 
• Select the new timeframe on the upper left (or enter a custom timeframe). 
• Click the box at the end of each row for the services to be duplicated. 
• Click the Duplicate button to add the services with the new timeframe. 
• Click Done to return to the Services List screen when done duplicating services.

Tip: When using Duplicate IEP, the old initiation and duration dates are removed 
from the new IEP. Enter the new dates on the cover page, select a date range on 
top of the Services page and then click the “To” button on the left of a service to 
automatically fill the selected initiation and duration dates.

Click in the second column to select the category for each service. This groups 
services for printing in the manner prescribed by the Vermont DOE. Make your 
selection according to the following priority order:
• ESY if Extended School Year Service; if not, then
• Trans if Transition Service; if not, then
• RS if Related Service; if not, then
• SpEd for all other special education services.

Click in the next three Services columns to select from a popup list, or double-
click to type in a different choice. Add to the lists by clicking the Edit User Value 
Lists button on IEP > Main Menu and then clicking the Services button. Some 
service types that can be billed for Medicaid, case management and related serv-
ices, appear in red (but print in black). Personnel Name and Personnel/Provider 
are in the same column. Personnel Name is blue to indicate that it doesn’t print 
on the IEP. It is used to generate reports to assist with Service Plans, scheduling 
and budgeting (go to Student > Main Menu and select the Find Services button). 
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By entering the names of personnel along with their titles in User Values, you will 
be able to select the names from a popup list when entering services in IEP’s 
and have the personnel title auto-fill.

Duration and Sessions are entered strictly as numbers in order to automatically 
calculate minutes per week for reports (see Find Services on Main Menu). Enter 
the Frequency by selecting Daily, Weekly, Monthly or Annually (new entries de-
fault to Weekly, so change it as appropriate). Examples:
• If service is three times a week, then Sessions 3, Frequency Weekly
• If twice a month, then Sessions 2, Frequency Monthly
• If service is quarterly, then Sessions 4, Frequency Annually

Enter the group size: Professional small group = 6 or less while Paraprofessional 
small group = 4 or less. Enter the Mode—D: Direct (professional), I: Indirect (e.g., 
para), C: Consult, M: Case Management, A: Assessment. The AutoLOC column 
is used by Medicaid clerks (see AutoLOC Feature in the Medicaid section). The 
trash can button can be used to delete a service line.

Next to the Print Services button are Print Options for printing everything found in 
the three Services tabs or just the current page.

Services Narrative

The second tab in this section includes several narrative items. The Narrative 
field can be used to describe services in more detail. The placement field in-
cludes a popup menu that corresponds to the placement list on Student: Main 
Data (if the selection differs from Main Data, a button appears - click it to update 
Main Data to match the new IEP). The participation field offers a popup list. To 
add items to the popup list, go to IEP: Main Menu and click on the Edit User 
Value Lists button.

Accommodations

The third tab in the Services section includes Accommodations. Identify any pro-
gram modifications or supports for personnel in the first field. The second field 
provides a narrative field for describing accommodations. This field is unneces-
sary if you detail the accommodations in the following section. 

Check one of the assessment boxes. If you check the first box, be sure to indi-
cate which accommodations will be used for state assessments and/or NDS (na-
tional, district and school assessments) by selecting the appropriate boxes after 
each accommodation. 

Enter one accommodation per text box (entering multiple accommodations in one 
text box may exceed the printing capacity).  Accommodations print grouped by 
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category, starting with Testing and then other categories alphabetically (but items 
without a category name assigned print first). There are three Print Options (only 
the third option prints the Review columns). 

Accommodations Bank

The Accommodations Bank works much the same as the Goal Bank. Accommo-
dations can be transferred from the Accommodations Bank to an IEP, but not vice 
versa (except, of course, through a copy and paste process). So, if you think 
you’ll eventually want an accommodation in the bank, it makes sense to enter it 
there initially. A major difference from the Goal Bank is that the Accommodations 
Bank is available to 504 Plans in addition to IEP’s. Another difference is that the 
Accommodations Bank is a list of separate accommodations, whereas the Goal 
Bank has objectives linked to goals. Consequently, selecting the “Enter Accom” 
button transfers just the selected accommodation to the current Plan. Further-
more, you stay in the Accommodation Bank until done selecting accommodations 
(a brief flash of the screen indicates that each accommodation transfers to the 
Plan at the time it is selected). 

Access the Accommodations Bank using the Open Accom. Bank button on the 
Accommodations layout (IEP > Services > Accommodations or from the 504 
Plan). Here you can view any accommodations that have been entered (SpEd-
Doc comes with a set of 133, including 26 NECAP allowable accommodations) or 
you can enter new ones. To add accommodations to the bank, click on the New 
Record button on top of the screen. To return to the current Plan without transfer-
ring anything to it, click on the Return button on top of the screen.  

To search the bank, use the Find button on top of the Accommodations Bank lay-
out. Then enter one or more search criteria and click Continue to view your re-
sults. Click an “Enter Accom” button to transfer an accommodation to the current 
Plan (the accommodation will be added to the Plan but you will remain in the Ac-
commodations Bank so you can select more). Click on the Return button to re-
turn to the Plan when you are done adding accommodations to the Plan. In the 
Plan, you can use the trash can button on the Accommodations layout to remove 
any that were mistakenly transferred to the Plan. Modifying accommodations in 
the Accommodations Bank is permanent, while changes made in a Plan are spe-
cific to that Plan.

IEP-at-a-Glance

Some schools may choose to print a condensed IEP-at-a-Glance document for 
some staff in place of the entire IEP. This feature is accessed through the Print 
IEP or At-a-Glance button on the IEP pages. The document includes some infor-
mation from the Cover Page, Present Levels (checking boxes to the right of Pre-
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sent Levels text boxes include those portions), Goals (but not objectives), Serv-
ices and Accommodations. The IEP-at-a-Glance can be printed to paper or as a 
PDF for electronic distribution (PDF printing requires FileMaker Pro 9 or newer).

Services Plan

The IEP form may be modified into a Services Plan for home and private school 
students simply by checking the box in the upper left hand corner of the IEP 
Cover Page. Then the desired portions of the IEP form may be completed and 
printed to create the Services Plan. For instance, a plan might consist of the fol-
lowing four pages: Cover, Present Levels, Goals and Services.

IEP Consents and Notices

Consent for Initial Provision

Consent for Initial Provision of Special Education Services is a one-page form 
(fields do not expand for printing). Most of the fields auto-fill based on information 
entered in Student.

Revocation of Consent

Revocation of Consent for Provision of Special Education Services is a one-page 
form (fields do not expand for printing). The placement can be described in two 
and a half lines or less (printing limit). The explanation text is not limited (the form 
will print as one page if eight or fewer lines are entered). Most of the fields auto-
fill based on information entered in Student.
Tip: Enter today’s date by clicking in a field and then keying Command-Dash 
(Command -). 

Not Attending (Written Agreement)

Written Agreement for Not Attending an IEP Meeting is a form to agree that an 
IEP team member will not attend a meeting. Create a new form by clicking the 
Not Attending button and then, in the ensuing portal, the New button. Click on the 
Go button in that portal to view and edit the newly-created agreement. You can 
also view existing Written Agreement records (but can’t create new ones) in Stu-
dent > Portals.

IEP Revisions (Written Agreement)
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Agreement to Revise the IEP Between Annual Review Meetings is a form to 
agree to an IEP change without a meeting. Create a new form by clicking the IEP 
Revision button and then, in the ensuing portal, the New button. Click on the Go 
button in that portal to view and edit the newly-created agreement. You can also 
view existing Written Agreement records (but can’t create new ones) in Student > 
Portals. 

Evaluation Plan and Report

Eval Main Menu 

To add items to the popup lists that appear in the Evaluation file, click on the Edit 
User Value Lists button on the bottom of Evaluation: Main Menu. This takes you 
to a layout with columns for each of the Evaluation popup lists. Additionally, in-
formation auto-fills when a disability is selected in the Disability Determination 
section. This information can be modified by selecting the Evaluations Questions 
button on Student > Main Menu (access requires a higher level password). 

Cover Page

If information is complete in the Student file, much of the top section will auto-fill. 
Click on the Fill from Meeting button to fill all the names from the latest meeting 
notice onto a cover page. Once entered, the Plan, Consent and Decision dates 
automatically transfer to Student. Note that the form now includes a place to re-
cord the date that consent for testing is received. Double-click the Name and Po-
sition fields to type in them. Single-click to select from a popup list. The User 
Value lists for the bottom part of the form (below the required team members) are 
Participant and Participant Title. There is a Yes/No popup to indicate who was 
involved in developing the plan, but participants are expected to initial agreement 
with the decision (or submit a dissenting report).

Also on the right side of the layout is a button to create an Evaluation Amend-
ment to document reconvening the team in order to review assessment results 
that were received following the Eligibility Decision meeting. If the team is deter-
mining a new primary disability, develop a new Evaluation rather than using this 
form. Click the “New” button to create a document that is similar to the cover 
page but includes additional information concerning changes made to the 
Evaluation. Team member names transfer from the original Evaluation, so it will 
be necessary to add or delete names to indicate participation in the amendment. 
Summarize the changes on the bottom of the Amendment document.

Click the Draft button on the left side of the cover page to print a document with 
Draft appearing on the pages. When completed, click the Written checkbox to the 
right of the cover page layout. This clears the Draft box, communicates to SpEd-
Doc users that the document is complete and locks the document to help prevent 
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accidentally overwriting it. Evaluations are also automatically locked a year after 
the Eligibility Decision date (a cob web appears at this point). Check the Unlock 
box on the left side of the cover to amend the report. There are also a pair of 
Find buttons that search Evaluations based on the completion date entered.

Disability Determination

This section has tabs for up to five disability areas. Click on a tab to select a sus-
pected disability. Questions auto-fill based on the disabilities selected on the tab 
(click in the fields to edit the auto-filled text). Type answers in the same field 
along with the questions. Enter the conclusion in Section B. Click the Section C 
popup to view to select from the eight assessment areas and titles of those re-
sponsible. A Big Edit button is available to the right of the Questions and Answers 
text field (click on a button to expand the data entry box). If you select multiple 
disabilities, each disability will have its own tab. Click on a tab to edit the informa-
tion for that disability.

There are three print buttons on top of the layout (use the third option for a very 
long Disability Determination section that otherwise exceeds FileMaker printing 
limits):
• Page: Print the current layout (one disability area).
• All: Print the entire Disability Determination section.
• Eval: Go to a dialog to print all or portions of the evaluation report.

Tip: To reselect a disability, don’t just change the name of the disability on the 
tab. Instead, click the Clear Page button to the right of the tabs to clear every-
thing on that page. Then when you select a new disability the corresponding new 
questions will fill in as well.

Adverse Effect

This section has tabs for up to nine basic skill areas. Click on a tab to select a 
basic skill area of concern. Required questions are built into the form (although 
additional questions may be entered into the Section A). If the team elects not to 
consider a question, deselect the checkbox to the right of that question so it 
doesn’t print. Click in the Section D popup to view and select from the six as-
sessment areas that will be considered for the basic skill and to indicate who will 
be responsible for each area. Section D always prints for the first tab, since it is 
acceptable to make a single list of assessments for all the basic skills. However, 
Section D will also print on any of the remaining tabs if data is entered in the As-
sessment or Responsible fields.
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Regulations only require documentation of adverse effect in one basic skill for 
eligibility. However, once eligibility has been determined, it remains important to 
identify if any additional basic skill areas need to be addressed in the IEP. An al-
ternative to creating a separate page for each basic skill is to select Additional 
Measures on one tab and list several basic skills on one page. In this way ad-
verse effect can be documented on at least one measure for these additional ba-
sic skills.

Need for Special Education

Questions auto-fill based on the disabilities selected on top of this form. Click in 
the fields to edit the auto-filled text. Big Edit buttons are available to the right of 
the text fields (click on a button to expand the data entry box).

Decision

Document the team’s decision. This page includes a written prior notice state-
ment. Be sure to also update the primary and secondary disabilities on Student 
Main Data.

Evaluation Consents and Notices

Eval Notice

Notice of a Special Education Evaluation is a one-page form (fields do not ex-
pand for printing). The form provides notice of an evaluation for eligibility or other 
purposes. Most of the fields auto-fill based on information entered in Student. 

Eval Consent

Consent for a Special Education Evaluation is a one-page form (fields do not ex-
pand for printing). All but the date auto-fills based on Student data. 

Evaluation Delay

Notice of Evaluation Delay is a one-page form (fields do not expand for printing). 
The form is restricted to initial evaluations since re-evaluations are no longer sub-
ject to the 60-day rule (they still need to be completed within three years of the 
prior evaluation). This is a one-page form, so fields do not expand for printing. 
Most of the fields auto-fill based on information entered in Student.
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No Re-evaluation (Written Agreement)

Written Agreement Between Parents and District – Re-evaluations is a form to 
agree that eligibility will be re-determined without an evaluation. Create a new 
form by clicking the Written Agreement button and then, in the ensuing portal, the 
New button in the No Re-evaluation section. Click on the Go button in that portal 
to view and edit the newly-created agreement. You can also view existing Written 
Agreement records (but can’t create new ones) in Student > Portals. Be sure to 
enter the parental signature date in Student > Tracking > Most Recent Eval. so 
that the next triennial date can be calculated.

Transfer Student (Written Agreement)

Completion of an Evaluation of a Transfer Student is a form to agree that an ini-
tial or re-evaluation of a transfer student will be completed later than would ordi-
narily be required. Create a new form by clicking the Written Agreement button 
and then, in the ensuing portal, the New button in the Transfer Student section. 
Click on the Go button in that portal to view and edit the newly-created agree-
ment. You can also view existing Written Agreement records (but can’t create 
new ones) in Student > Portals.

Meeting

The Notice and Minutes forms include a Duplicate Record button to create a new 
record. Use this if you want to retain the old record in the database while creating 
a new Notice or Minutes form. The Duplicate Record feature retains some data 
from the original form, e.g., the names of meeting participants.

Meeting Main Menu

To add items to the popup lists that appear on forms in Meeting, click on the Edit 
User Value Lists button. This takes you to a layout with columns for each of the 
Meeting popup lists that are user editable. 

Notice

The meeting date and time will appear bold. You may optionally enter an end 
time for the meeting. Double-click the Name and Position fields to type in them. 
Single-click to select from a popup list. The User Value lists for the bottom part of 
the form (below the required team members) are Participant and Participant Title. 
The IEP and Evaluation cover pages include a Fill from Meeting button to fill all 
the names from the latest meeting notice onto a cover page.

25



Tip: Save time by allowing the program to auto complete data. For instance, en-
ter 11/15 and the program will auto fill Monday, 11/15/04. Enter 10 for 10:00 AM 
or 10pm for 10:00 PM (FileMaker assumes AM unless you enter PM).

Minutes

This is not a state-mandated form. The Minutes form may be used to take min-
utes during a meeting (there is capacity to print 10 pages of minutes for a meet-
ing). Other users prefer to print the form to bring to the meeting as a cover page 
for minutes. The list of names on the Notice automatically appears on the Min-
utes form. After the parent name, there is a place for the parent to initial that s/he 
was informed of parental rights.

Next Steps

This form is used to invite parents to their first IEP meeting when the child is 
transitioning from FITP to EEE.

LEA Refusal and Decision

Notice of LEA Refusal (Form 7) and Notice of LEA Decision (Form 7a) contain 
four narrative fields that expand to include all the text you enter (those fields con-
tain scroll bars once you exceed the original boundaries). The Procedural Safe-
guards Contact can be selected from a popup by clicking on the name field (if the 
name and contact information have been entered in the User Values – Main 
Menu > Edit User Value Lists > Other), or you can type it in (typically, the special 
education director is the contact for the SD/SU).

Medicaid

Access the Medicaid records through the second tab on Student: Portals. Since 
the logs are now separate from the main Medicaid record, you only need one 
Medicaid record per student while you may have multiples of one or more of the 
provider forms. Detailed instructions for the Medicaid forms are in the SpEdDoc 9 
Medicaid Guide.

Section 504

Access Section 504 forms through the third tab on Student: Portals. Section 504 
forms are largely self-contained, i.e., they are a complete set of forms independ-
ent of the various special education forms elsewhere in the database. However, 
all students need to be entered on the Main Data and Contacts screens in Stu-
dent before proceeding (but disregard those fields that only apply to special edu-
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cation, e.g., Placement, DD Domain, Category, Disability). Several forms that list 
team member names have a Fill from Meeting List button to transfer the names 
you entered on the Section 504 Meeting Notice to the current form.

To add items to the popup lists that appear on forms in Section 504, go to one of 
the forms and select Edit User Value Lists - current area under Scripts on the 
FileMaker toolbar. This takes you to a layout with columns for each of the Section 
504 popup lists that are user editable. Click the Coordinator button to enter your 
Section 504 Coordinator into SpEdDoc. The Section 504 Coordinator’s name and 
contact information are blue on the User Value List to indicate that the adjacent 
name and address are related. Once entered in User Values, selecting the coor-
dinator’s name on the bottom of any of the 504 Evaluation forms will automati-
cally enter the coordinator’s name and contact information on the following two 
forms for the current student: “What is Section 504” and “Summary of Parent/
Student Rights.” Access these two documents by clicking the buttons on any of 
the 504 Evaluation layouts under the print buttons (the documents are not stu-
dent specific, so may be reproduced for future use). 

The student-specific Section 504 forms include:
Evaluation section:
• Evaluation Report – To document the evaluation process and conclusion.
• Referral – To refer a student suspected of having a 504 disability.
• Referral Notice – To notify parents that the 504 process is commencing.
• Notice and Consent – To obtain parental permission for a 504 evaluation.
• Decision Notice - To notify parents of a decision regarding a 504 disability.
Meeting and Minutes section:
• Meeting Notice – To notify parents of a 504 meeting and its purpose.
• Minutes – To document meeting discussion and decisions.
Plan section:
• Plan – To document what will be done to support a 504 student.

Keyboard Shortcuts
There are a variety of time-saving keyboard shortcuts (some are also available 
from the FileMaker toolbar). Here are a few commonly-used shortcuts:

• Control - X (Mac: Command - X) – Cut
• Control - C (Mac: Command - C) – Copy
• Control - V (Mac: Command - V) – Paste
• Control - - (Mac: Command - -) – Enters today’s date
• Control - J (Mac: Command - J) – Find all records
• Shift - Print button – Shows preview of the current layout
• Right click (Mac: Control click) on word with red underlining to show a contex-
tual menu with Suggested Spellings (FM8 or newer).
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• Right click (Mac: Control click) on a field to show a contextual menu with an op-
tion to Cut (clear the data).
• Right click (Mac: Control click) on the vertical band on the left hand side of the 
FileMaker toolbar to add or remove toolbars (Standard and Text Formatting are 
available).
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Reporting Scores in Columns 

Overview of the Process

The key to creating aligned columns that print well is to, in SpEdDoc: 
• Use a mono-spaced font such as Monaco or Courier New. 
• Create columns using Option-Tab (Mac) or Control-Tab (PC) without adding individual 

spaces with the spacebar.

If you plan to copy from Microsoft Word, don’t use Tables. Instead, in Word:
• Use a mono-spaced font such as Monaco or Courier New. 
• Create columns by tabbing (without adding individual spaces with the spacebar).

Select the Font and Enter the Scores

You could use the mono-spaced font for the entire field or just the section with 
columns. To apply the mono-spaced font to all the text in a field:
• Click in the field and Select All (Option-A (Mac) or Control-A (PC)).
• Go to Format on the FileMaker toolbar and select a mono-spaced font, e.g., Font 

>Courier New.
• Type the labels and scores, creating columns by tabbing with Option-Tab (Mac) or 

Control-Tab (PC).

This aligns columns in the default left-justified manner and should print similar to 
what you see on the screen. 

Setting Tabs on the Text Ruler

To set tabs and right-justify columns for a more polished look:
• Go to the View menu and select "Text Ruler."
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• Click in a field (and Select All if you've already entered text) to view the margin set-
tings.

• Click in the ruler to set a tabs for each column (they can be dragged left or right later). 
• Double-click on the tab to view the Tabs dialog box and set attributes such as align 

right.

In the following image, two tabs have been set and both have been switched 
from left to right justified. Enter your scores by typing and tabbing, and press En-
ter after the final line to bring the cursor below the last line of scores. The col-
umns will appear as follows:

Adjust the placement of the columns by highlighting that section and dragging the 
tab marks in the Text Ruler.

Note that the Tabs dialog box also 
allows other options such as align-
ing a column of numbers based on 
a decimal number. For further in-
formation on this and other aspects 
of tabbing, click on Help on the 
FileMaker toolbar and conduct a 
search on “Specifying tab settings” 
to locate the following topic: Speci-
fying paragraph attributes and tab 
settings.
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